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The Open System Gateway Owner’s Manual is designed to help you become
more familiar with the functions and procedures of the Open System
Gateway. For information on the Third Party System, refer to the manuals
with the system or contact the vendor for the Third Party System. For more
information about Landis & Gyr Field Panels, refer to the Landis & Gyr
Powers Field Panel User’s Manual (P/N  125-1895).

This manual is organized to provide maximum usability: sections are
arranged according to the order of the gateway software menu screens.

The Open System Gateway (OSG) resides on the same network as the field
panels and allows the Third Party System access to the network. The OSG is
viewed the same as any other network node and during start-up will need to
be added to the system as such. This allows the Third Party System operator
workstation to communicate with the System 600 field panels.

In order for you to effectively use this manual, the following must have been
completed:

• Gateway software loaded, and user logged on

• Gateway added as a node on the Protocol 2 (P2) network

• Gateway and Third Party System successfully communicating

• System 600 commissioned

• Gateway commissioned

• Third Party System network commissioned.

Introduction

Prerequisites
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The gateway supports 11 of the 12 standard System 600 point types; the
LCTLR point type is not supported. Subpoints are not supported and must be
unbundled if the gateway is to share them with the Third Party System.

The following describes the 11 point types supported by the gateway point.
For each point type, the letters that are placed in the parentheses identify the
proper designation for that point type.

Logical Analog Input (LAI)  - Monitors the value of analog input point
(used for temperature, flow, pressure, etc.).

Logical Analog Output (LAO) - Provides one commandable analog
output point (used to position valves and dampers).

Logical Digital Input (LDI)  - Monitors the state of a digital input point
(used on 2-position devices such as fans, etc.).

Logical Digital Output (LDO) - Provides one commandable digital
output point (used for 2-position devices such as fans, etc.).

Logical FAST/SLOW/STOP Latched (LFSSL) - Provides two
commandable latched digital outputs (FAST/SLOW/STOP) and one
optional digital input used as a proof.

Logical FAST/SLOW/STOP Pulsed (LFSSP)  - Provides three
commandable pulsed digital outputs (FAST/SLOW/STOP) and one
optional digital input used as a proof.

Logical ON/OFF/AUTO Latched (LOOAL) - Provides two commandable
latched digital outputs and one digital input that can be used as a proof
point.

Logical ON/OFF/AUTO Pulsed (LOOAP) - Provides two commandable
pulsed digital outputs (ON/OFF) and one commandable latched output
(AUTO). You can use the digital input as an optional proof point.

Logical Pulsed Accumulator (LPACI) - Counts pulses of one digital
input point.

Logical Two State Latched (L2SL)  - Provides one commandable
latched digital output (ON/OFF) and monitors one digital input for proof.

Logical Two State Pulsed (L2SP)  - Provides two commandable pulsed
digital output (ON/OFF) and monitors one latched digital input as a proof
point.

The gateway does not support bundled points. All points must be unbundled
for use with the gateway.

Gateway Point
Types

Supported Point Types

Unbundling Points
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To select an item from a menu, press the key corresponding to the
capitalized letter in the desired item. For example, if you press [T] while in the
Log On menu, the time and date of the gateway will be displayed.

Press [ESC] at any menu to return to the previous menu. Press [ESC] at the
Log On menu to exit the gateway software. Once you’ve exited the software,
you must reboot or power cycle the device to begin the application again.

When a field has been added or modified, [ENTER] must be pressed to
confirm the entry. Using the up or down ([↑] [↓]) arrows to move out of a field
will return the field to its previous value.

When you are finished entering information, press [F9] to confirm and save
changes.

A listing of the software’s features is shown in Table 1.

Table 1.  Gateway Software Functions.

If you want to ... Under this Main
menu submenu...

Use this menu item...

change the time or date Log On Time

log on Log On Hello

display the gateway’s
revision number

Log On Version

add, edit, delete, find, copy
points

Point Edit

initialize the gateway’s
database

Point Edit, Init_dbase

display all the gateway’s
points

Point Summary

write a summary report to
file

Point Report

change the logon
password

Setup Password

configure ports, change
baud rate on gateway

Setup pOrts

configure ports, change
baud rate on third party
system

Setup pOrts

enable Auto Connect on
the gateway

Setup pOrts

Menu Procedures

Software Features
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Table 1.  Gateway Software Functions.

If you want to ... Under this Main
menu submenu...

Use this menu item...

enable Auto Connect on
the third party system

Setup pOrts

display a log of real-time
traffic on the gateway
(useful for troubleshooting)

Log Start

stop/pause the log display Log sTop

erase the log display Log Clear

write a display to file Log File

display only certain entries
in logs

Log sEt_filter

connect the gateway to the
System 600 and initialize
the System 600 network
driver

Network System 600

disconnect the gateway
from the System 600
network

Network System 600

connect the gateway to the
third party system

Network Open System

disconnect the gateway
from the third party system

Network Open System

exit the gateway software Bye
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Log On items include Time, Hello, and Version.

System600: IDLE   000      - Open System Gateway -      OpenSystem: IDLE   000

Main:  Time  Hello  Version  <ESC>

Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 1.   The Log On Menu.

Press [T] to display the time and date. To change these settings:

1. Exit the gateway software.

2. Type TIME, press [ENTER].

3. When prompted, enter the correct time and date and press [ENTER].

NOTE:  The date and time in the gateway are unaffected when date and/or
time synchronization is done to nodes on the P2 network.

Press [H] and wait for the system to prompt you for a password. The default
password is WHART, which may be entered in either upper or lower case.
Through the Main menu, editing, diagnostic and configuration functions are
available. The password may be changed in the Setup menu discussed later
in this manual.

Press [V] to display revision information for this gateway.

Log On

Time

Hello

Version
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The Main menu is displayed after a valid password has been entered in the
Log On menu.

System600: IDLE   000      - Open System Gateway -      OpenSystem: IDLE   000

Main:  Time  Point  Setup  Log  Network  Bye  <ESC>

Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 2.   The Main Menu.

Press [T] to display the time and date. To change these settings:

1. Exit the gateway software.

2. Type TIME [ENTER].

3. When prompted, enter the correct time and date and press [ENTER].

4. Reboot the gateway by pressing <CTRL><ALT><DEL> simultaneously
or power cycle the the device.

Press [P] to display the following Point options: Summary, Report, and Edit. A
description of each follows:

Summary

Press [S] to display all of the points in the gateway's database. An example of
the Summary fields is shown in the screen below.  This is not a dynamic
screen.

System600: IDLE   000      - Open System Gateway -      OpenSystem: IDLE   000

Point:  Summary  Report  Edit  <ESC>

Cab# Name Descriptor Type Present Value Priority Status

10 LAI101 LAI POINT LAI 0.00 P:NONE *A*
10 L2SL L2SL -?- P: -?- -?-
20 LPACI LPACI PNT LPACI -?- P:-?- -?-
10 LAO040 LAO POINT LAO 2.00 P:NONE *AC*
10 LDOM HAND LDO LDO Inactive P:NONE -N-
20 LOOAL LOOAL -?- P:-?- -?-
20 LFSSL LFSSL PNT LFSSL -?- P: -?- -?-
02 LAI1 1 LAI -?- P: -?- -?-

 Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 3.   The Point Summary Menu.

Main Menu

Time

Point
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Below is a list of the Summary fields and a description of each.

• Cab# – The cabinet number is the node number of the cabinet in which
the point resides on the System 600 network.

• Name – The Name is the System 600 point name. It contains the unique
System 600 logical point name.

• Descriptor – The Descriptor is the System 600 point descriptor. It
contains the 12 character descriptor entered when the point was
configured at the field panel.

• Point Type – The gateway supports the 11 of 12 point types supported by
System 600 Field Panels. The gateway does not support bundled
subpoints, those must be unbundled at the MBC/RBC.

• Present Value – The Present Value is the current state or value of the
System 600 point. The Present Value for digital points is either active or
inactive. For analog points, the Present Value is a real number or an
integer value.

• Priority – The priority indicates the points current priority. It will be one of
the 5 possible priorities: OPER, SMOKE, EMER, PDL, NONE.

• Status – The status indicates the current status of the point. (i.e. In
Alarm, Failed, Disabled, etc.).

For Present Value, Priority, and Status a “?” indicates that the COV Link is
not presently active for the point.

Report

Press [R] to write a report, in the same format as the report summary, to the
POINT.LOG file on the root directory of the gateway MMI computer.

NOTE:  Each time a report is written to the POINT.LOG file, the previous
report is overwritten. To print out this report, exit the gateway software and
copy the POINT.LOG file to a floppy diskette. This is a text file that can be
printed, or displayed, using any ASCII text editor, such as the DOS editor
EDIT.

Edit

Press [E] to get all of the choices for adding, modifying, or deleting points
from the gateway database. Both networks must be idle before the Edit
functions can be used. An error message will be displayed if the user tries to
edit when either network is ONLINE.
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System600: IDLE  000   - Open System Gateway -    OpenSystem: IDLE  000

 Point:  Edit:  Add  Find  Next  Previous  Modify  Copy  &  <ESC>

Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 4.  The Edit Screen.

NOTE:  The Point Edit menu has 8 functions available, however only the first 6
are displayed on the screen, refer to Figure 4. Press [&] to display the other 2
available commands, refer to Figure 5. Press [&] again and return to the first
screen.

System600: IDLE  000   - Open System Gateway -    OpenSystem: IDLE  000

Point:  Edit:  Delete  Init_dbase  &  <ESC>

Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 5.  The Second Edit Screen.

The Edit screens are specific to the type of point being added or modified.
Fields which can be edited are highlighted. Fields which allow only certain
specific entries are toggle fields. The value can only be selected by pressing
the space bar until the desired selection is displayed. Press [ENTER] to save
the current value and move the cursor to the next field.

All of the Edit menu selections, except Add, can be used for the displayed
point, referred to by the gateway as the Current Point. The Add option creates
a new point which then becomes the Current Point.

NOTE:  An error message is displayed when no Current Point is selected
during an operation which requires one.

Different screens are displayed for adding than for modifying points because
certain fields are not applicable for a new point, and other fields cannot be
modified once a point is created.
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Because there are too many Edit menu selections to fit onto one screen, the
screen is divided into two submenus. You can toggle between the two Edit
submenu screens using the ampersand key ([&]) described below.

Add

Press [A] to add a point entry to the database. A Current Point is not required
since this function creates a new one. Select the point type desired by
pressing the space bar; press [ENTER] to record your choice. Enter the
System 600 cabinet number and press [ENTER]. Type in the System 600
point name and press [ENTER]. The new point becomes the Current Point
when the creation has been confirmed with [F9]. The point is then added to
the gateway’s database.

System600: IDLE   000    - Open System Gateway -    OpenSystem: IDLE   000

Point:  Edit:  Add  Find  Next  Previous  Modify  Copy  &  <ESC>

                     S600 Cabinet # ----> 10
                     S600 Point Name ---> LAI101
                     Point Descriptor -->
                     S600 Point Type ---> LAI
                     Present Value -----> -?-
                     Point Status ------> ????
                     Point Priority ----> P: -?-

[ESC] = Return To Previous Menu                           [F9] = Process Entry
[↓], [↑] = Escape Field                               [RETURN] = Confirm Entry
Landis & Staefa, Inc. (C) 1992-1998                     <ESC> To Exit.

Figure 6.   The Add Submenu.

Find

Press [F] to locate a point, display it, and make it the Current Point. The
gateway’s database is searched using the point’s name.

Next

Press [N] to locate and display the next point in sequence and make it the
Current Point. A message will be displayed in the prompt field if there are no
more points in the sequence.

Previous

Press [P] to locate and display the previous point in sequence and make it
the Current Point. A message is displayed in the prompt field if there are no
more points in the sequence.

Edit submenus
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Modify

Press [M] to move the cursor into the Name field of the Current Point. A
Current Point must be displayed before the point can be modified. An error
message is displayed if there is no Current Point.

Copy

Press [C] to create a new point of the same type as the Current Point. Fields
normally entered in the Create screen are copied from the Current Point. The
name field is left blank and a unique name entered for the point.

&

Press [&] to toggle between the two Edit menu screens.

Delete

Press [D] and confirm the deletion to remove the Current Point from the
gateway’s database. The next point in the database becomes the Current
Point and is displayed. If there are no more points in the sequence, no
Current Point is displayed.

Init_dbase

Press [I] to clear and initialize the gateway’s database. A warning prompt is
displayed because this operation will delete all of the points in an existing
database. The Init_dbase function may be performed at any time to clear the
database and start over.

The Setup menu modifies setup parameters used by the gateway and can be
accessed by pressing [S] from the Main menu. These parameters include
port configuration, baud rate, gateway name, and password.

Password

Press [P] to select a new gateway password. The default password
(WHART) should be changed once a gateway is operational. Passwords can
be up to 12 characters long. They may contain letters or numbers and are not
case sensitive. Spaces, dollar signs and periods are allowed. Changes to the
password are confirmed, encrypted, stored by the gateway, and are effective
upon the next startup of the software.

pOrts

From the Setup menu, press [O] to display information used by the gateway
to establish communications between the gateway and System 600 devices.
The pOrts menu screen is shown in Figure 7.

Setup
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System600: IDLE   000    - Open System Gateway -    OpenSystem: IDLE  000

Setup:  Password  pOrts  <ESC>

                   Powers System 600
                      Node Number ----------> 98
                      Com Port ----------------> Com 1
                      Baud Rate --------------> 9600
                      Auto Connect -----------> N

                   Open System Gateway
                      Gateway Name --------> POWERS
                      Com Port ---------------> Com 2
                      Baud Rate --------------> 9600
                      Timeout (x500mSec)--> 5
                      Auto Connect -----------> N

[ESC] = Return To Previous Menu [F9] = Process Entry
[↓], [↑] = Escape Field [RETURN] = Confirm Entry
Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 7 .  The pOrts Menu .

The “Timeout” of the Open System Gateway should be greater than any
timeout set on the workstation.

“Autoconnect” will connect the gateway to the chosen network upon Open
System Gateway startup.

Press [L] to display a log of real time traffic on the gateway. The format of this
display is shown below.

NOTE:  The log function greatly reduces the LAN’s communication speed
and should be used sparingly. Always use the sTop log command when not
monitoring or diagnosing gateway communications or system functions.

System600: IDLE   000    - Open System Gateway -    OpenSystem: IDLE   000

Log:  Start  sTop  Clear  File  sEt_filter  <ESC>

Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 8.  Log Screen.

The first field in the log display contains an internal  code assigned by the
gateway.  The first letter of this code indicates which system the message
originated from.  “N” indicates the message was created by the System 600
network.  “F” indicates the message was created by the non-System 600
workstation.

Log
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The second field in the log display contains the time an event occurred. The
time is displayed in the following format, including one hundredths of a
second:  HH:MM:SS:HH.

The last field in the log display contains a message describing the specific
event or error that occurred.  Messages such as “COV Reporting Enabled”
and “COV Received” are normal operation messages.  Communication
failures or operational inefficiencies are also reported on the Log screen.  The
following table is a list of potential error codes and their definitions.

Table 2.  Error Codes.

Value Meaning Interpretation
0x01 Global Error Connection to the System 600 network has

not been established, connection to the
workstation has been lost, or an OSG internal
error has occurred.  It is assumed that all data
points connected to the OSG have invalid
data.

0x02 Invalid
Operation

The type of command or point value is
inappropriate or not allowed.

0x03 Point Not
Found

The requested point is either not defined on
the System 600 network or is not defined in
the OSG.

0x04 Priority Too
Low

The priority of the request is lower than the
priority of the point.

0x05 Status
Unchanged

The status of the point has not been changed
by the Write Point Status request.

0x06 No Response The request is waiting to be sent over the
System 600 network or the OSG is still waiting
for a response from the network.

0x07 Point Failed Indicates a hardware problem of the System
600 end device.

0x08 Point out of
Service

The point has been disabled by the operator
and cannot be altered until it has been re-
enabled.

0x0B Value
Unchanged

The point is already at the value or state that
was requested.  No change was necessary.

0x0C Value Out of
Range

The requested value was outside the normal
range of the point.

0x1B Service Not
Available

Either the OSG and/or the System 600 will not
support the requested operation or the OSG’s
capacity has been exceeded.

0x39 Node Failed The OSG could not communicate with the
System 600 controller.

0xFF Unspecified Unspecified Error

Start

Press [S] to start logging or continue the log display if it has been paused.

Stop
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Press [T] to stop or pause the log display.

Clear

Press [C] to clear the log display screen.

File

Press [F] to display the File command’s submenus. The File command
captures the log information and writes it to the GATEWAY.LOG file. The files
are limited to five hundred lines, so if the log is left ON line 501 line will
overwrite line one in the log, line 502 will overwrite line two and so on.

System600: IDLE   000     - Open System Gateway -   OpenSystem: IDLE   000

Log:  File:  Begin  End  Clear  <ESC>

Landis & Staefa, Inc. (C) 1992-1998 <ESC> To Exit.

Figure 9.  File Submenus.

Submenus of the File menu include Begin, End and Clear.

Begin

Press [B] to begin logging to the GATEWAY.LOG file. This will overwrite any
existing GATEWAY.LOG.

End

Press [E] to end writing to the GATEWAY.LOG file. Messages will  continue
to be displayed on the screen.

Clear

Press [C] to clear the GATEWAY.LOG file. New messages will continue to
be logged to file.

File submenus
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Use the following commands to display, print, rename, or copy the
GATEWAY.LOG file.

To display the GATEWAY.LOG file follow these steps:

1. Exit the gateway software.

2. Enter the command TYPE GATEWAY.LOG and press [ENTER].

The gateway log is displayed.

To save a particular sequence, copy it to a floppy disk so that it will not be
overwritten by the gateway the next time the gateway logs to a file.

To copy the GATEWAY.LOG file to a floppy disk follow these steps:

1. Exit the gateway software.

2. Place a formatted floppy disk in the drive.

3. Type COPY GATEWAY.LOG A:  [ENTER].

The GATEWAY.LOG file is now copied to the root directory of the diskette in
drive A:.

NOTE:  This is a text file that can be printed, or displayed, using any ASCII
text editor, such as the DOS editor EDIT.

Set_filter

Press [E] to set a filter which will restrict the log messages displayed on the
screen and written to file (if file logging is enabled) according to the type and
source of the message.

Setting the Message Level to Error, for example, and setting all of the Display
Message From fields except System 600 Translator to <N>, eliminates all
traffic except COVs received from the System 600.

NOTE:  The settings on this screen are not saved by the gateway on exit and
must be reentered each time this feature is used.

File features
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System600: IDLE   000    - Open System Gateway -    OpenSystem: IDLE   000

Log:  Start  sTop  Clear  File  sEt_filter  <ESC> E

                   Message Level ----------> Critical

                   Display Messages From:
                      Parameter Files ------> Y
                      Host ---------------------> Y
                      MMI ---------------------> Y
                      Database --------------> Y
                      Service -----------------> Y
                      Native Translator ----> Y
                      Foreign Translator --> Y

[ESC] = Return To Previous Menu                           [F9] = Process Entry
[↓],[↑] = Escape Field                               [RETURN] = Confirm Entry
Landis & Staefa, Inc. (C) 1992-1998                     <ESC> To Exit.

Figure 10.  Set_filter screen.

The Network menu commands allow stopping and restarting of the System
600 and Third Party System networks which is necessary when adding or
modifying the gateway’s database.

CAUTION:

Before adding points to the gateway’s database, the
System 600 and the Open System networks must be
taken offline. Editing points while the gateway or Third
Party System devices are online may result in the loss of
your entire database.

The Network menu commands may be useful during the setup and
commissioning of a gateway, but should not be needed for normal operation
because the networks are started automatically once the setup is complete.
The first Network menu is displayed by pressing [N] from the Main menu.

Network
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System600: IDLE  008  - Open System Gateway -  OpenSystem: IDLE   006

Network:  System_600  Open_system  <ESC>

Landis & Staefa, Inc. (C) 1992-1998                        <ESC> To Exit.

Figure 11.  Network Menu.

System_600

Press [S] to activate the connection selections for the System 600 network.

Stop

Press [T] to stop the System 600 driver immediately. This will disconnect the
gateway from the System 600 network. The System 600 network can be
rejoined by using the Start command.

Start

Press [S] to initialize communication with the System 600 network and
perform any startup sequences necessary to begin communication on the
System 600 network.

Open_system

Press [O] to activate the connection selections for the Third Party System
network.

Stop

Press [T] to stop the Third Party System driver immediately. This will
disconnect the gateway from the Third Party System network. The Third Party
System network can be rejoined by using the Start command.

Start

Press [S] to initialize communication with the Third Party System and perform
any startup sequences necessary to begin communication on the Third Party
System network.
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System600: IDLE   008   - Open System Gateway -   OpenSystem: IDLE   006

 Bye:  OK To Log You Off? (Y/N)?

Landis & Staefa, Inc. (C) 1992-1998                     <ESC> To Exit.

Figure 12. Bye Menu.

Press [B] at the Main menu to bring up the Log Off screen.

Press [Y] to return to the Main menu.

Bye
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